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Getting Started

This chapter describes the Cisco ANA NetworkVision working environment and how to access the 
Cisco ANA NetworkVision tools and commands.

The Cisco ANA NetworkVision window provides access to all Cisco ANA NetworkVision's 
functionality.

• Starting Cisco ANA NetworkVision, page 2-1 describes how to login to Cisco ANA NetworkVision.

• Cisco ANA Security, page 2-3 describes the enhanced security provided when working with and 
managing the Cisco ANA system.

• Cisco ANA NetworkVision Window, page 2-5 describes the Cisco ANA NetworkVision window, 
including the tree pane, workspace and properties pane, ticket pane, toolbar and menus.

• Changing a User Password, page 2-31 describes how the user can change their login password.

• Selecting Cisco ANA NetworkVision Map and Alarm Options, page 2-31 describes how to 
customize Cisco ANA NetworkVision’s startup and display options.

• Logging Out, page 2-32 describes how to log out of Cisco ANA NetworkVision.

Starting Cisco ANA NetworkVision
This section provides instructions for launching the Cisco ANA NetworkVision application. Cisco ANA 
NetworkVision is password protected to ensure security. Before you start working with Cisco ANA 
NetworkVision make sure you know your username, password and the Cisco ANA Gateway IP address 
or hostname that you require.

Note If a user does not login to the Cisco ANA Manage, NetworkVision or EventVision applications during a 
specified period of time (the default is one month) the user’s account will be automatically locked. The 
default period can be changed per user in Cisco ANA Manage. The period of time is measured from the 
time the user last logged out of any of the Cisco ANA Client applications.

The security level required in order to perform the specific Cisco ANA NetworkVision function is 
indicated in this User Guide by means of icons. 

For more information about the icons used, see Cisco ANA Security, page 2-3.
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To start Cisco ANA NetworkVision:

Step 1 From the Start menu, select the Programs folder, then Cisco ANA/Cisco ANA NetworkVision. 

or

Click on the Cisco ANA NetworkVision quick launch icon in the taskbar. The Cisco ANA 
NetworkVision Login dialog box is displayed.

The last four Cisco ANA Gateways to which the user logged in successfully are displayed in the Host 
dropdown list. The list is displayed in chronological order with the most recent Cisco ANA Gateway 
displayed at the top of the list.

Step 2 Enter your User Name, and Password. 

Step 3 Enter the required Cisco ANA Gateway’s information in the Host field, as an IP address or hostname,

or

Select a Cisco ANA Gateway from the Host dropdown list.

Note The Cisco ANA Gateway IP address or hostname that was used when you last logged in is 
automatically displayed at the top of the Host dropdown list.

Note Make sure that you use the leading IP address (the IP on which the Cisco ANA Gateway was 
configured) when logging in to the system.

Step 4 Click OK. The Cisco ANA NetworkVision window is displayed.

Note When logging in there is an update on minor fixes.

Note The Cisco ANA NetworkVision window appears empty when it is opened for the first time. You 
can create a new map and/or open a map that has been previously saved, see Chapter 4, “Working 
with Cisco ANA NetworkVision Maps”, in order to view a network.

After logging in to Cisco ANA NetworkVision and launching the application, you may customize 
Cisco ANA NetworkVision’s Options, namely, Start / Display /Audio settings, for example, you can:

• Load the workspace with information when starting NetworkVision

• Display network elements in the NetworkVision Map and tree panes

• Configure audio responses when different alarms are triggered

For more information on how to customize Cisco ANA NetworkVision’s startup and display options, see 
Selecting Cisco ANA NetworkVision Map and Alarm Options, page 2-31. 
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Cisco ANA Security
Cisco ANA provides enhanced security when working with and managing the Cisco ANA system. Users 
are assigned permission levels for an operational scope, which enable them to perform only the functions 
assigned to the scope and defined security level. A user can be assigned more than one security level.

Permission

The user’s ability to perform certain tasks. There are two types of permissions, namely, default and NE 
related. 

• Default—The default permission only applies to the activities that are related to GUI functionality, 
not the activities related to network elements. For example, a user with the default permission 
Viewer can view maps and the Device List. For more information, refer to Cisco Active Network 
Abstraction Administrator’s Guide.

• Network Element—The NE related permission enables the administrator to group a collection of 
managed network elements together (in Cisco ANA Manage) in order to enable the user to view 
and/or manage the NEs based on the user’s role or permission. After the user is allocated a scope 
(list of network elements) and a role, the user can then perform various activities on the network 
elements, for example, manage alarms in Cisco ANA NetworkVision. For more information, refer 
to Cisco Active Network Abstraction Administrator’s Guide.

Roles

Cisco ANA implements a security engine that combines a role-based security mechanism that is applied 
on scopes of network elements granted per user. The system supports user accounts creation, multiple 
network element scope definition and a set of five pre-defined roles for security and access control to 
allow different system functions:

This guide uses the icons displayed above (listed in order from lowest to highest security level) to 
indicate the security level required in order to perform specific Cisco ANA NetworkVision functions.

Note A user with a higher security level can perform all the Cisco ANA NetworkVision functions assigned to 
a user with a lower security level.

Table 2-1 Security and Access Control Roles

Viewer—Read only access to the network and to non-privileged system functions.

Operator—Configure business tags and perform most day-to-day operations.

Operator Plus—Able to fully control alarm life cycle and create maps.

Configurator—Activate services, and configure the network.

Administrator—Manage the system configuration and security.
2-3
Cisco Active Network Abstraction NetworkVision User Guide, Version 3.6

OL-12500-01



 

Chapter 2      Getting Started
    Cisco ANA Security
Each user is assigned a permission level for an operational scope, which enables the user to perform 
certain tasks. Every user has a private username and password. A user can login from any workstation 
with the user’s own set of permissions and operational scope.

When a user does not have the required permission level to perform a function the appropriate menu 
option or button is disabled. 

The administrator is responsible for defining the types of activities that the user can view and perform 
using Cisco ANA Manage.

For more information about user security and defining operational scopes, refer to the Cisco Active 
Network Abstraction Administrator’s Guide.

Roles can be granted per scope or at an application level (default permission), namely, all the activities 
that are related to GUI functionality, not the activities related to devices. The default permission 
includes:

• Application login.

• Manage alarms in Cisco ANA NetworkVision.

• Manage maps—Creating, deleting, and opening.

• Map manipulation—Arrange map, including, aggregations, adding NEs, NEs placement in map, 
map background and so on.

• Business tag management.

Scopes

A scope is a named collection of managed network elements that have been grouped together in order to 
allow a user to view and/or manage the network elements provided a given role. Grouping can be based 
on geographical location, network element type (such as DSLAM, router, SW, and so on), network 
element category (such as access, core, and so on) or any other division according to the network 
administrator’s requirements.

Using NetworkVision, a user that has been assigned a scope can view and/or manage the NEs within this 
scope according to the role assigned to the user as per the scope. The user cannot view any information 
regarding NEs that are outside the user’s scope, including basic properties, inventory, and alarms.
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Cisco ANA NetworkVision Window
The Cisco ANA NetworkVision window with an open map is displayed below. 

Figure 2-1 Cisco ANA NetworkVision Window

The Cisco ANA NetworkVision window is divided into three main areas or panes, as follows:

• Tree Pane

• Workspace, including the map pane, device view and links view.

• Ticket Pane

1 Menu bar

2 Toolbar

3 Workspace

4 Status bar

5 Ticket pane

6 Hide/display ticket pane

7 Tree pane
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Note The ticket pane can be displayed or hidden by clicking the arrows below the tree pane.

The status bar which is the horizontal area at the bottom of the main Cisco ANA NetworkVision window 
and other Cisco ANA NetworkVision windows provides information about the current state of what you 
are viewing in the window relating to the application. There are two states, namely, Connected and 
Reconnecting. It also displays what is happening to the command that has been sent while the application 
is waiting for an answer.

In addition, the memory utilization bar in the status bar displays the amount of memory used by the 
client. By default if memory utilization exceeds 60% it is colored yellow and if it exceeds 80% it is 
colored red. The default percentage and color values can be configured in the registry.

Dragging the borders of the Cisco ANA NetworkVision window adjusts the size of each pane. The tree 
pane, and workspace are correlated; this means that selecting an option in the one pane affects the 
information displayed in the other pane.

Some of the functions that the Cisco ANA NetworkVision window enables you to perform are:

• View the network.

• View device properties.

• View physical and logical inventory information.

• View a complete list of the physical links and their status.

• View link properties.

• View and manage tickets.

Tree Pane
The tree pane displays a tree-and-branch representation of the network elements and aggregations 
defined for the loaded map.

The highest level of the tree pane displays the map name, for example, the name of a geographic region, 
country or a state. When the map name is changed, the Cisco ANA NetworkVision window is updated. 
The new map name is displayed at the top of the tree pane and in the title bar of the window between 
brackets.

The lowest level of the tree pane displays a single NE, for example, a router and the device name or the 
name of the business tag. The tool tip displays the NE name, NE type and IP address. For information 
about the status of Network Objects, see Status of Network Objects, page 2-15.

Workspace
The workspace enables you to view and modify low-level information. It includes the following areas: 

• Map Pane—Displays managed network elements on a geographical map. For more information see 
Map Pane, page 2-7.

• Device View—Displays the details of the network devices contained in the currently selected 
hierarchy or sub-network (map), for example, the IP Address and Vendor. For more information see 
Device View, page 2-9.

• Links View—Displays a complete list of the links shown in the map pane and their status. For more 
information see Links View, page 2-11.
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When a user switches between the map pane, device view and links view the following is preserved:

• The network elements and/or links selected

• The sorting preferences

• The filtering preferences, as defined using:

– The Map Options dialog box, see Filtering Links According To Type, page 4-17.

– The Filter dialog box, see Defining a Filter, page 3-2.

– The links view collection method, see Filtering Links Using the Collection Method, page 7-10.

Map Pane

Cisco ANA NetworkVision displays managed network elements in the map pane. In addition, the map 
pane displays the links or aggregated links and relationships between the network devices, aggregated 
nodes (topology), and networks on a geographical map.

Each NE is displayed using a NE icon, the color of which reflects severity, as described in the Map Pane, 
page 2-7. In addition, a management state or alarm icon is displayed together with the IP address. For 
more information see Appendix A, “Icon Reference”. The tool tip displays the NE name, NE type and 
IP address.

The links or aggregated links that are presented in the map pane:

• Display arrowheads if they are unidirectional

• Do not have arrowheads if they are bi-directional

Note A maximum number of 4000 links can be displayed in the map (configurable in the registry). If this 
number is exceeded a warning message is displayed and all the lines (links) are removed from the map 
(they are still displayed in the links view). In addition, the map is surrounded by a red border. Filtering 
the links may reduce the number of links so that the client can return to a normal state.

The links display tool tips that provide you with information regarding the number of links and partially 
describe the list of links. Physical links are highlighted in bold. 

Note If there is a link filter applied to the map then the links tool tip displays only the relevant links.

The map pane enables network objects to be viewed down to the device level. An example of the map 
pane is displayed in the Cisco ANA NetworkVision Window, page 2-5.

The devices can be moved manually on the geographical map by dragging the required device. In 
addition, clicking Layout on the toolbar or using the Zoom tools in the menu bar can change the way 
that the devices are displayed on the map.

Note Click Map pane on the toolbar to display the map pane in the Cisco ANA NetworkVision window.

Some of the functions that can be performed using the right-click shortcut menu in the map pane are:

• View device inventory. For more information see Chapter 6, “Viewing Network Device Inventory”.

• Aggregate devices. For more information see Chapter 4, “Working with Cisco ANA NetworkVision 
Maps”.
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• Create and attach business tags. For more information see Chapter 10, “Working with Business 
Tags”.

• Create and view tickets. For more information see Chapter 8, “Working with Tickets”.

• Change the view and content of network maps. For more information see Chapter 4, “Working with 
Cisco ANA NetworkVision Maps”.

• Communicate with network devices. For more information see Chapter 4, “Working with 
Cisco ANA NetworkVision Maps”.

• Configure the topology. For more information see Chapter 7, “Working with Links”.

• View device information, namely, device properties. For more information see Chapter 5, “Viewing 
Device Properties”.

Note Most of these functions can also be performed from the tree pane’s right-click shortcut menu.

When working with this functionality for MPLS VPN networks, refer to the Cisco Active Network 
Abstraction Managing MPLS User Guide.

The following icons are used to display the network elements in the Cisco ANA NetworkVision 
window’s tree pane and map panes:

Table 2-2 Device Icons

Icon Device

Unmanaged Network

Network, sub-network or logical aggregation

Router 

Generic SNMP 

Ethernet Switch 

DSLAM 

ATM switch 

BRAS

Ping VNE

Viewable by a user with a higher permission level

Ghost device
2-8
Cisco Active Network Abstraction NetworkVision User Guide, Version 3.6

OL-12500-01



 

Chapter 2      Getting Started
    Cisco ANA NetworkVision Window
Note When Cisco ANA NetworkVision detects a network device for which there is not enough information 
available, the device is displayed as a ghost device on the map. In this case, the user is unable to view 
the ghost device's properties or communicate with the ghost device. When the ghost device's information 
is updated, its icon is replaced with the relevant device icon and all the related device information and 
communication become available.

The following colors are used to display the severity (or propagated severity) of a network device when 
displayed in the map pane, tree pane and ticket pane:

• Red—Critical.

• Orange—Major.

• Yellow—Minor.

• Sky Blue—Warning.

• Green—Cleared/Normal/OK.

• Dark Blue—Information.

Note The Information severity does not affect the severity (color) of the network object.

• White—Indeterminate.

The same coloring conventions apply to the link severity displayed in the map pane and links view. 

Note The color of a selected link is customizable. The default color is blue.

When an aggregated node is selected in the tree pane, the map pane displays the devices contained within 
the aggregated node and the relationships between them.

For more information about how the status of a network device is displayed in the map pane, see Status 
of Network Objects, page 2-15.

Device View

The device view displays the details of the network devices contained in the currently selected hierarchy 
(map), for example, the IP Address and Vendor.

Note • Click Device View on the toolbar to display the device view in the Cisco ANA NetworkVision 
window.

• Locked devices only display Managed Element information and the locked device icon.

• Use the scroll bar to view all the columns in the table.

The following columns are displayed in the device view:

• Managed Element—The device name of the element managed by Cisco, as defined in Cisco ANA 
Manage. It also displays a device icon, the color of which reflects severity. In addition, the 
management state or an alarm icon is displayed.
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• IP Address—The IP address used for managing the device as a hyperlink that opens the properties 
of the relevant device.

• System Name—The system name of the device, as defined in the device's MIB, for example, Router. 
If it is Telnet then it is the prompt.

• Communication State—The communication status with the device or VNE, for example, Device 
Unreachable. For more information see Management State, page 2-17.

• Investigation State—The investigation status of the VNE, for example, normal, initializing, 
maintenance or unsupported.

• Element Category—The device category, for example, Router or ATM-Switch.

• Element Type—The device type (manufacturer name), for example, Cisco 7200.

• Vendor—The vendor name.

• Up Since—The date and time when the device was last reset.

• Sending Alarms—The status of alarms on the device, namely, enabled (true) or disabled (false) in 
the Cisco system. This can be enabled on only part of the device.

Warning There is an option to add the System Description, Location and Contact columns to the device view, 
however, this will increase memory consumption. Changing these settings must be done with the 
support of Cisco Professional Services.

Note Clicking on a red triangle displayed in a cell expands the cell to display all the information. You can also 
use a tool tip to view all the information.

The following buttons are displayed in the device view toolbar:

See Chapter 3, “Working with Cisco ANA NetworkVision Tables”, for more information about filtering 
and finding details about a device displayed in Cisco ANA NetworkVision’s tables, and for the keyboard 
shortcuts used for accessing table functionality.

Table 2-3 Device View Toolbar

Export to CSV—Enables you to export the information displayed in the 
device view. Either the selected row(s) is exported or when nothing is selected 
the entire table is exported.

Sort Table Values—Enables you to sort the information displayed in the 
device view, for example, according to element category.

Filter—Enables you to define a filter for the tickets displayed data displayed 
in the table according to a selected column. 

Note When a filter is applied the Set Selection Filter button is activated.

Previous Selection Filter—Enables you to undo the last applied filter 
selection. 

Rewind All—Enables you to undo previous filter selections, and displays all 
the original information in the device view. 
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Some of the functions that can be performed using the right-click shortcut menu in the device view are:

• View device information, namely, device properties. For more information see Chapter 5, “Viewing 
Device Properties”.

• View device inventory. For more information see Chapter 6, “Viewing Network Device Inventory”.

• Configure the topology. For more information see Chapter 7, “Working with Links”.

• Configure and view Business Tag information. For more information see Chapter 10, “Working with 
Business Tags”.

Note Clicking on a header in the device view sorts the information displayed, for example, according to an 
Element Category.

Links View

The links view is displayed in the Cisco ANA NetworkVision window when clicking  on the toolbar.

When the user views a map, it may, for example, have many links or aggregated links. This may make it 
difficult for the user to view the links that are required. The links view enables the user to clearly view 
the required links, and in addition the user can easily search for a specific link. The links view provides 
the user with an easy to access complete list of the various types of links displayed on the map (the links 
view is context sensitive). The user can also view the status of the link. 

Note You can view and filter the links according to type using the Map Options dialog box. For more 
information see Filtering Links According To Type, page 4-17.

Note Business links are part of the links view. For information about business links, refer to the Cisco Active 
Network Abstraction Managing MPLS User Guide.

Any links that are added or removed from the map are automatically added or removed from the links 
view provided they have not been filtered out. 

The links view is selection sensitive, namely, the links displayed in the links view depend on the context 
selected in the tree pane or map pane. For example, if an aggregated node or aggregated link is selected 
then the links of the selected context are displayed in the links view.
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The links view is displayed below.

Figure 2-2 Links View

Note An external link has a gray cell background in the table, and the Inventory window can be opened by 
clicking the hyperlink. For more information about external links, see Working in Links View, page 7-8.

The following columns are displayed in the Links View window:

• Context—The name of the map, aggregated node or sub-aggregated node containing the link.

• Severity—Displays a severity bell icon, which is colored according to the severity of the alarm on 
the link. This indicates the impact of the alarm on the network. For more information about severity, 
see Map Pane, page 2-7.

• A End-Point—The device or site that is the source of the link as a hyperlink to the inventory of the 
device or site.

• Bi Directional—The direction of the link, namely, true (bi-directional) or false (unidirectional). If 
the link is unidirectional (false) then the traffic is from A->Z.

• Z End-Point—The device or site that is the destination of the link as a hyperlink to the inventory 
of the device or site.

• Link Type—The type of link, for example, Physical Layer, VPN or MPLS.

Note Clicking on a header in the links view sorts the information displayed, for example, according to 
Severity.
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The following additional buttons are displayed at the top of the links view (navigation sensitive) and 
enable you to filter the links using the collection method:

For more information about filtering and sorting links in links view, see Working in Links View, 
page 7-8.

Ticket Pane
When Cisco ANA detects faulty behavior in the network, the VNEs and their internal Device 
Components initiate an internal, end-to-end message flow, resulting in full understanding and 
containment of the fault across all relevant network elements and network layers. 

The ticket pane is displayed beneath the tree pane and workspace in the Cisco ANA NetworkVision 
window. The ticket pane can be displayed or hidden by clicking the arrows displayed below the tree pane. 
For the definition of a ticket, alarm and event, see Events, Tickets and Alarm Definitions, page 1-3.

For more information about tickets, refer to the Cisco Active Network Abstraction EventVision User 
Guide.

A network event is a discrete occurrence or happening in the network at a specific point in time. Events 
are determined from incoming traps, syslogs and detected device changes. A system event is an 
occurrence or happening, usually significant to the performance of a function, operation or task in the 
Cisco ANA system. Examples of events include port status change; device reset or reloads of a 
Cisco ANA VNE. Cisco ANA EventVision enables you to view the event history. For more information, 
refer to the Cisco Active Network Abstraction EventVision User Guide.

Tickets represent an entire lifecycle within the system and include a chain of related events and alarms, 
from the time that the alarm is opened (when the change in behavior is first detected) until it is 
acknowledged, resolved and closed. Examples of alarms are link down, device unreachable or module 
out. Some event types are capable of creating tickets. When an event is generated it is correlated to an 
existing event which is correlated to a ticket. If there is no existing ticket then a new ticket is created.

The ticket pane enables you to view and manage tickets as well as pinpoint the source of the ticket. All 
the tickets that are reported by Cisco ANA are stored in Cisco ANA Gateway’s database. 

Cisco ANA identifies the relationship between a root cause alarm and its consequent alarms. It 
automatically correlates the consequent alarms as “children” of the root alarm. The ticket pane displays 
the ticket (namely, the root cause alarm) and the Ticket Properties dialog box enables you to view all 
correlated alarms.

All Links—Displays the complete list of links for the selected context (map, 
aggregation, or sub-aggregation), namely, the list is not filtered and all the 
links are displayed (including external links).

External Links—Displays the links where only one side of the link starts in 
this context (map, aggregation or sub-aggregation) and the other side ends 
somewhere else, namely, is not in the map or is outside the currently selected 
context.

Flat Links (Surface)—Displays the links currently visible on the map for the 
selected context (map, aggregation or sub-aggregation), excluding, any 
thumbnails.

Deep Links—Displays the links for the current aggregations and the 
sub-aggregations where both of the endpoints are somewhere within the 
currently selected context.
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Note The root cause alarm severity is the topmost severity of its contained alarms.

The ticket pane enables you to perform the following functions:

• View all the tickets or only the filtered tickets of a selected device. For more information about 
filtering tickets, see Filtering Tickets by Device, page 8-4.

• View and filter all the tickets according to specified criteria 
see Filtering Tickets by Criteria, page 8-4.

• View and acknowledge tickets.

• View the properties of a ticket, including the history, correlated alarms, and affected parties.

• Clear a ticket.

• Remove a ticket.

• Clear and remove a ticket.

• Locate the source of a ticket in the map.

• Sort the tickets displayed.

The following columns are displayed in the ticket pane:

• Severity—Displays a severity bell icon, which is colored according to the severity of the alarm. This 
indicates the impact of the alarm on the network, namely, one of the following:

– Red—Critical.

– Orange—Major.

– Yellow—Minor.

– Sky Blue—Warning.

– Green—Cleared/Normal/OK.

– Dark Blue—Information.

Note The Information severity does not affect the severity (color) of the network object.

– White—Indeterminate.

For more information about severity, see Map Pane, page 2-7.

• Ticket ID—The sequential ID number of the ticket.

• Short Description—The supported ticket name. 

Note Rule-based alarms can be configured per customer site or upon request.

• Location—The entity that triggered the ticket, as a hyperlink that opens the relevant location.

• Last Modification Time—The date and time when the ticket was last modified. The ticket is 
modified when a user acknowledges the ticket or when an event is correlated.

• Time—The date and time when the initial ticket occurred.

• Acknowledged—The status of the ticket that is being handled, namely, acknowledged (true) or 
unacknowledged (false).
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• Affected Devices—The number of devices affected by the ticket (the source(s) of the alarm and their 
subsequent alarms).

• Correlation Count—Displays the number of correlated alarms included in the ticket. For example, 
if in the Correlation tab of the Ticket Properties window, there are 3 alarms correlated to the root 
cause alarm, then the counter displays the number 3. If there are 2 alarms correlated to the root cause 
alarm, and each alarm in turn has 2 alarms correlated to it, then the counter displays the number 4.

• Reduction Count—Displays the number of alarms included in the ticket. For example, nine alarms 
can be viewed in the History tab of the Ticket Properties window, but only a single ticket is displayed 
in the ticket pane.

• Duplication Count—Displays the number of occurrences of the original root cause alarm included 
in the ticket. For example, if the ticket was created by a link down root cause alarm, and then the 
link goes up and down again quickly so that it is included in the same ticket, then the duplication 
counter displays the number 2, as the root cause alarm occurred twice.

The ticket details in the ticket pane change constantly as they are updated with new information. For 
example, Port Down is updated to Port Up.

The tickets in the ticket pane are by default sorted according to Ticket ID. For information about tickets, 
see Chapter 8, “Working with Tickets”.

The Location field displays the number of selected rows and the total number of rows in the table, for 
example, 2/16 Selected. In addition, it displays the location of the selected row(s) in the table, for 
example, Line 3.

The Find field enables you to search for information in the ticket pane table according to the selected 
column. For more information about the buttons displayed in Cisco ANA NetworkVision’s tables and 
table functionality, see Working with Tables, page 3-1.

For more information about how the status of a network device is displayed in the ticket pane, see Status 
of Network Objects, page 2-15.

Status of Network Objects
The status of a network object is displayed in Cisco ANA NetworkVision in the following ways:

• Severity

• Management State

• Tickets

Severity

Severity indicates the “operational health” of the network device. At any give time an icon has only one 
severity value and this value is displayed using the severity colors. For more information about the colors 
used to display the severity (or propagated severity) of network devices and links, see Map Pane, 
page 2-7.

Propagation

Severity is propagated upwards in the network hierarchy, displaying the topmost severity of its children 
and so ensuring that every single problem in the network is propagated and visible.
2-15
Cisco Active Network Abstraction NetworkVision User Guide, Version 3.6

OL-12500-01



 

Chapter 2      Getting Started
    Cisco ANA NetworkVision Window
The same severity propagation rules that are used for network elements, apply to links. A link is a child 
object of an aggregation if and only if it is fully contained in the aggregation; namely, the network 
elements on both sides of the link are part of the aggregation, as displayed in the examples below.

Figure 2-3 Link Severity Example 1

In the example above there is a critical link (#1) between two NEs in an aggregation. This will affect the 
severity of the aggregation (#2), namely, the aggregation will be critical because it contains a link with 
a critical severity. Link severity affects the context.

Figure 2-4 Link Severity Example 2

In the example above there is one critical link (#1) that forms part of an aggregated link. This will affect 
the severity of the aggregated link (#2), because it contains a link with a critical severity.

New Ticket Propagation

A new ticket indicates a new local fault or accumulates and propagates the number of new faults in its 
children. New tickets are propagated upwards, displaying the number of new tickets and the topmost 
severity.

When new tickets are accumulated, a label is displayed in the tree pane and map pane, based on the 
following formula:

<n> <s> [+]

The color of the bell displays the topmost severity level(s).

1 2

18
01

11

1 2

18
01

12

Where:

n = Displays the number of tickets with the highest severity in the new ticket count.

s = Displays the highest severity level in the new tickets:

• C = critical

• M = major

• m = minor

• W = warning

• N = normal (cleared alarm)

+ = Indicates that additional, less severe tickets (optional) exist
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Examples:

• An object with three critical new alarms, two major alarms and one warning alarm is labeled 3C+.

• An object with five minor new alarms is labeled 5m.

Management State

The management state indicates the state/mode of the software component (a VNE) managing a network 
device and the communication with it. This enables you to determine the accuracy of the network 
information and the availability of the Cisco ANA VNEs in order to carry out network operations. 

Management states are always local indications and are not propagated. A partial exception to this rule 
is the propagation of unreachable network elements. 

The management state indication only applies to network elements and network element components. A 
network object can only have one state, for example, unsupported or initializing.

A network device icon consists of two components, a device icon and an overlay icon that reflects the 
status, namely, the severity, management state or new alarm. 

The device icon displays a symbol of the network device and the color of the symbol displays the severity 
(or propagated severity) of the network device. For more information about device icons, see Device 
Icons, page A-1. For more information about severity colors, see Map Pane, page 2-7.

A small overlay icon is displayed on top of the device icon to indicate the management state in the tree 
pane and map pane. For example, a Router that Cisco ANA failed to access (unreachable) is displayed 
as illustrated below: 

Figure 2-5 Device with Overlay Icons

Cisco ANA NetworkVision supports the following management states:

1 Alarm icon

2 Device icon

3 VNE Management State icon

1

2

3 18
01

57

Table 2-4 Management States

Priority Value Description Tree Pane Map Pane

Unsupported The VNE does not support the network object 
hardware or software version or a device module.

Initializing The VNE or VNE component is in startup mode or 
is temporarily non-operational.

VNE 
Unreachable

Cisco ANA Gateway received no response from 
the VNE.
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More than one management state can occur at the same time. In this case, a single overlay icon is 
displayed reflecting the device status based on the following priorities: Unsupported > Initializing > 
VNE Unreachable > Device Unreachable > Partially Supported > Operational.

Tickets

A bell icon is displayed in the tree pane, map pane and ticket pane to indicate tickets. Every alarm is 
assigned a severity level, representing the impact of the fault on the network device. The bell icon 
displays the severity level of the topmost alarm. An example is displayed below.

Cisco ANA NetworkVision Toolbar
The Cisco ANA NetworkVision toolbar is context-sensitive and the options vary depending on your 
selection in the application. 

Note The functionality (available on the toolbar and menus) that is accessible to the user depends on the 
permissions defined for the user.

Device 
Unreachable

Cisco ANA failed to access the device.

Partially 
Supported

The group of devices is supported in general, but 
the specific device is only partially supported.

Maintenance The VNE state was manually changed to 
maintenance or when adaptive polling is 
implemented (CPU usage is high), so the VNE is 
no longer polled and the VNE automatically 
moves to maintenance mode (for more 
information, refer to the Cisco Active Network 
Abstraction Administrator Guide. The NE is 
working (status Up), but if there are any alarms or 
tickets that are generated on the device they will 
not be sent to the application.

 

Unknown The device (ghost) type is unknown.

Operational Fully functional. NE icon NE icon

Table 2-4 Management States (continued)

Priority Value Description Tree Pane Map Pane

Value Tree Pane Map Pane

Ticket
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The Cisco ANA NetworkVision window contains the following tools:

Table 2-5 Cisco ANA NetworkVision Toolbar

Button Function

Creates a new map in the database.

Opens a file/map saved in the database using the Open dialog box.

Saves the current map, for example, the background and the location of 
devices, to the database.

Adds a device to the map or to the sub-network selected in the tree pane and 
displayed in the map pane.

Adds a VPN (that has not yet been loaded) to the currently displayed map. For 
more information, refer to the Cisco Active Network Abstraction Managing 
MPLS User Guide.

Opens the Inventory window enabling you to view the physical and logical 
inventory of a device.

Aggregates the devices selected in the map pane of the Cisco ANA 
NetworkVision window and enables you to define a name for the aggregated 
device. 

Opens the Map Options dialog box, enabling the network administrator to 
display or hide different types of links on the map and in the links view.

Defines the size of a selected device(s) or aggregated nodes in the map pane, 
according to predefined sizes or according to a percentage of the current size.

Choose and display an overlay of a specific VPN on top of the devices 
displayed in the network map of the map pane using the Choose Overlay dialog 
box.

When a VPN in the network is selected all the devices and links that are part 
of the VPN are colored and those that are not part of the VPN are grayed out. 
The ones that remain highlighted are the provider edge routers and the physical 
links that carry the LSP that is being used by the VPN. For more information, 
refer to the Cisco Active Network Abstraction Managing MPLS User Guide.

After a selection is made by clicking Choose Overlay, displays or hides a 
previously defined overlay of a specific VPN on top of the physical devices 
displayed in the network map of the map pane.

For more information, refer to the Cisco Active Network Abstraction Managing 
MPLS User Guide.

Opens the Find Business Tag dialog box, enabling the network administrator 
to find and/or delete a business tag according to a name, key or type.

Moves up a branch in the tree pane and map pane in order to view different 
information.

Finds a device or aggregated node in the network/map according to the name.
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Menu Bar
This section provides a description of each option available in the Cisco ANA NetworkVision menus. 
The following menus are available:

• File Menu

• Edit Menu

• View Menu

• Node Menu

• Tools Menu

• Window Menu

• Help Menu

Note Based on the security level and access permissions assigned to a user, some of the menu options may not 
be available. 

Note The menus are context-sensitive and the options vary depending on your selection in the application.

Defines the way in which the map lays out the NEs in the map pane of the 
Cisco ANA NetworkVision window, namely, Circular, Symmetric, tree or 
Hierarchical.

Displays the device view in the Cisco ANA NetworkVision window (the button 
toggles when selected or deselected).

Displays the links view in the Cisco ANA NetworkVision window (the button 
toggles when selected or deselected).

Displays the map pane in the Cisco ANA NetworkVision window (the button 
toggles when selected or deselected).

Opens a window displaying an overview of the network.

Activates the normal selection mode (the button toggles when selected or 
deselected).

Activates the pan mode, which enables you to move around in the map pane by 
clicking and dragging (the button toggles when selected or deselected).

Activates the zoom selection mode, which enables you to select an area in the 
map pane to be enlarged by clicking and dragging to view the selected area (the 
button toggles when selected or deselected).

Fits the entire sub-network/map in the map pane.

Table 2-5 Cisco ANA NetworkVision Toolbar (continued)

Button Function
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File Menu

The File menu displays the following options (for more information see Chapter 4, “Working with 
Cisco ANA NetworkVision Maps”):

New Map

Creates a new map in the database.

Open

Opens a file/map saved in the database using the Open dialog box.

Close Map

Closes the map currently displayed in the Cisco ANA NetworkVision window.

Load Path Tracer

Loads a Cisco ANA PathTracer map from a previously saved file in the Cisco ANA PathTracer 
Multi-Path window.

Add Device

Opens the device view and enables you to add a device to the map or to the sub-network selected in the 
tree pane and displayed in the map pane. This option is enabled when a map is open and you have the 
relevant security level, namely, OperatorPlus.

Add VPN

Adds a VPN (that has not yet been loaded) to the currently displayed map. For more information, refer 
to the Cisco Active Network Abstraction Managing MPLS User Guide.

Note When you create a VPN or load a VPN Service View map, you may add and configure tunnels using a 
shortcut menu. For more information, refer to the Cisco Active Network Abstraction Managing MPLS 
User Guide.

Save Map

Saves the appearance of the map, for example, the background and the location of devices, to the 
database. This option is enabled when a map is open and you have the relevant security level, namely, 
OperatorPlus.

Save As Image

Saves the active map as an image and automatically displays the Save as Image dialog box. Use this 
dialog box to save an image using a different file format or name. 

Print Preview

Displays each map, as it will look when printed. 
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Print

Prints the active map as displayed in the Print Preview dialog box. 

Exit

Exits the Cisco ANA NetworkVision application and saves the workspace.

Edit Menu

The Edit menu displays the following options:

Find in Map

Searches for a device in the network/map that contains the specified text in the name or the IP fields.

Find Business Tag

Searches for business tag information in the database.

Resize

Displays the Resize dialog box, enabling you to define the percentage used to resize device icon(s) or 
aggregated nodes in the map pane.

Note The Resize option is only available when a device icon(s) or aggregated nodes are selected.

View Menu

The View menu displays the following options:

Layout

Defines the way in which the map is displayed in the map pane of the Cisco ANA NetworkVision 
window’s workspace, namely, Circular, Symmetric, Tree or Hierarchical. 

Overview

Opens a window displaying an overview of the network map.

Zoom In

Zooms in on the network map. 

Zoom Out

Zooms out of the network map. 

Fit In Window

Displays the entire network map in the map pane. 
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Normal Select

Activates the normal selection mode. The selected option is grayed out.

Pan

Activates the pan mode, which enables you to move around in the map pane by clicking and dragging. 
The selected option is grayed out.

Zoom Selection

Activates the zoom selection mode, which enables you to select an area in the map pane to be enlarged 
by clicking and dragging to view the selected area. The selected option is grayed out.

Node Menu

The Node menu displays the following options:

Note Most of the functionality available in this menu is only available when a device icon or an aggregated 
node is selected in the tree or map pane.

Inventory

Displays a dialog box enabling you to view the physical and logical inventory. For physical inventory 
you can view all the components of the device, for example, modules and ports. In addition, you can 
view the status of each component. For logical inventory you can view all the profiles and VC or routing 
tables of the device. For more information see Chapter 6, “Viewing Network Device Inventory”.

Aggregate

Groups the selected devices into an aggregation in the map pane of the Cisco ANA NetworkVision 
window’s workspace and enables you to define a name for the aggregated node. For more information 
see Chapter 4, “Working with Cisco ANA NetworkVision Maps”. 

Disaggregate

Ungroup the selected aggregated node in the tree pane and map pane of the Cisco ANA NetworkVision 
window. All the nodes in the selected aggregation move up one level and the selected aggregation is 
removed. For more information see Chapter 4, “Working with Cisco ANA NetworkVision Maps”.

Note Only available when an aggregated node is selected in the tree or map pane.

Mark as A Side

Starts the process of creating a new static link. This option is enabled when a device, port or unmanaged 
network is selected.
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Mark as Z Side

Launches the Add Static Link dialog box, enabling you to create a static link between to the two selected 
nodes. This option is enabled after a device, port or unmanaged network is selected and after the Mark 
as A Side option is selected.

Note When the user selects two ports, the Add Static Link dialog box is not displayed.

Properties

Displays a dialog box enabling you to view the properties of the selected device, for example, the 
severity, IP address and communication state. For more information see Chapter 5, “Viewing Device 
Properties”.

Tools Menu

The Tools menu displays the following options:

Change User Password

Enables you to change the password used when logging in to the Cisco ANA Client application suite. 
The change will take effect the next time that the user logs in to the application.

Note The administrator can also change your password in Cisco ANA Manage. 

Options

Enables you to customize several of Cisco ANA NetworkVision’s options, for example, load workspace 
on startup. For more information
see Selecting Cisco ANA NetworkVision Map and Alarm Options, page 2-31.

Window Menu

The Window menu displays the names of all the maps open in the Cisco ANA NetworkVision window’s 
workspace enabling you to move between the maps. 

Help Menu

The Help menu provides the user with information about Cisco ANA NetworkVision and provides 
access to the Help.

Cisco ANA NetworkVision Help

Opens the Cisco ANA NetworkVision online Help.

Cisco.com

This option is currently unavailable in this version.
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About Cisco ANA NetworkVision

Displays application information about Cisco ANA NetworkVision, for example, the version number.

Shortcut Menus
Right-clicking in a specific area or on a link, device or alarm in the Cisco ANA NetworkVision window 
opens the following shortcut menus:

• Device Shortcut Menu

• Map Shortcut Menu

• Aggregated Node Shortcut Menu

• Link Shortcut Menu

• Links View Shortcut Menu

• Ticket Shortcut Menu

A shortcut menu is displayed when you right-click in many of Cisco ANA NetworkVision’s dialog boxes 
or tables. For example, you can open a map from the Map List dialog box using the shortcut menu. The 
options displayed vary depending on the dialog box or tables currently displayed and the selection. For 
more information about any of the shortcut menu options displayed, refer to the options discussed in this 
section.

Note • Based on the security level and access permissions assigned to a user, some of the menu options may 
not be available. 

• The menus are context-sensitive and the options vary depending on your selection in the application, 
for example, the shortcut menus for NEs and aggregated nodes are different.

Device Shortcut Menu

The Device shortcut menu is displayed when you right-click a device in the tree pane, and workspace.

Note The Device shortcut menu is context-sensitive and the options vary depending on your selection in the 
application. Some options may not be available when multiple devices are selected.

Inventory

Displays a window enabling you to view the physical and logical inventory. For physical inventory, you 
can view all the components of the device, for example, modules, ports, and its IP address or configured 
VLANs. In addition, you can view the status of each component. For logical inventory, you can view all 
the profiles and VC tables of the device. For more information see Chapter 6, “Viewing Network Device 
Inventory”.

Aggregate

Aggregates the devices selected in the map pane of the Cisco ANA NetworkVision window and enables 
you to define a name for the aggregated device. For more information see Chapter 4, “Working with 
Cisco ANA NetworkVision Maps”.
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Disaggregate

Ungroup the selected aggregated node(s) in the tree pane and map pane of the Cisco ANA 
NetworkVision window. For more information see Chapter 4, “Working with Cisco ANA 
NetworkVision Maps”.

Note Only available when an aggregated node is selected in the tree or map pane.

Attach Business Tag

Attaches a business tag to the selected network element. For more information see Chapter 10, “Working 
with Business Tags”.

Detach/Edit

You can detach or edit a business tag from the selected Network Object. For more information see 
Chapter 10, “Working with Business Tags”.

Note The Detach and Edit options are only displayed when a business tag is attached to a Network Object.

Filter Tickets

Filters the tickets shown in the ticket pane so that it only displays the tickets of a selected device/network 
element.

Resize

Displays the Resize dialog box that enables you to define the percentage used to resize the device icon(s) 
or aggregated nodes in the map pane.

Remove from Map

Removes the selected device and all its children from the map (tree pane and workspace). The device 
that has been removed is still maintained in the network.

Save as new map

Creates a new map and places the selected aggregation as the root, while leaving the original map intact.

Tools

The Tools option contains the following sub-menu options:

• CPU Usage—Displays memory and CPU usage information for a device/network element.

• Ping—Pings the device from the client station.

• Telnet—Communicates with the device using the Telnet window from the client station.
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Topology

The Topology option enables you to:

• Add a new static link between two devices.

• Add new static topology between a device and an unmanaged network.

It contains the following sub-menu options in order to define the A Side and Z Side of the link:

• Mark as A Side

• Mark as Z Side

When working with VPNs in VPN Service View, the Topology sub-menu allows you define and 
configure tunnels. For more information, refer to the Cisco Active Network Abstraction Managing MPLS 
User Guide.

Properties

Displays the properties of the selected device, for example, IP address and system name. In addition, you 
can open the VNE Properties dialog box and manage VNE properties. For more information see 
Chapter 6, “Viewing Network Device Inventory”.

VNE Tools

Changes the status of the VNE by starting or stopping the VNE. For more information see Chapter 5, 
“Viewing Device Properties”.

Management

It contains the following sub-menu options:

• Command Builder—Defines commands and scripts using the Cisco ANA Command Builder tool 
(Configurator security level required). For further information, refer to the Cisco Active Network 
Abstraction Command Builder User Guide.

• Soft Properties Management—Extend VNEs by adding SNMP MIB and/or Telnet/SHH/TL1 
properties to the device’s collected information model using the Cisco Extended Properties Manager 
wizard (Administrator security level required). For further information, refer to the Cisco Active 
Network Abstraction Customization User Guide. 

Map Shortcut Menu

The Map shortcut menu is displayed when you right-click anywhere on a map in the map pane. 

Go to Parent

Goes to the parent in the tree pane and map pane in order to view different information.

Go to Root

Goes to the root in the tree pane and map pane in order to view different information.
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Aggregate

Creates an aggregation of the selected nodes in the tree pane and map pane of the Cisco ANA 
NetworkVision window and enables you to define a name for the aggregation. For more information see 
Chapter 4, “Working with Cisco ANA NetworkVision Maps”.

Filter Tickets

Filters the tickets shown in the ticket pane so that it only displays the tickets of a selected device/network 
element.

Aggregated Node Shortcut Menu

The Aggregated Node shortcut menu is displayed when you right-click on an aggregated node in the map 
pane.

Aggregate

Aggregates the devices selected in the map pane of the Cisco ANA NetworkVision window and enables 
you to define a name for the aggregated device. For more information see Chapter 4, “Working with 
Cisco ANA NetworkVision Maps”.

Disaggregate

Ungroup the selected aggregated node in the tree pane and map pane of the Cisco ANA NetworkVision 
window. For more information see Chapter 4, “Working with Cisco ANA NetworkVision Maps”.

Note Only available when an aggregated node is selected in the tree or map pane.

Filter Tickets

Filters the tickets shown in the ticket pane so that it only displays the tickets of the selected aggregated 
node.

Rename

Renames the selected aggregated node.

Resize

Defines the size of selected devices or aggregated nodes in the map pane according to predefined sizes 
or according to a percentage of the current size.

Remove from Map

Removes the selected aggregated node and all its children from the map (tree pane and map pane). 

Save as New map

Creates a new map and places the selected aggregation as the root, while leaving the original map intact.
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Show Thumbnail

Displays a thumbnail of the selected aggregated node in the map pane, including all the aggregated 
devices.

Show as Aggregation

Displays the aggregated node in the map pane.

Note The Show as Aggregation option is displayed in the shortcut menu when a thumbnail is displayed in the 
map pane.

Link Shortcut Menu

The Link shortcut menu is displayed when you right-click a link in the map pane. For more information 
see Chapter 7, “Working with Links”.

Filter Tickets

Filters the tickets shown in the ticket pane so that it only displays the tickets of a selected Network 
Object.

Properties

Displays the properties of the selected link.

Links View Shortcut Menu

The Links View shortcut menu is displayed when you right-click a link in the links view table displayed 
in the Cisco ANA NetworkVision window’s workspace. For more information see Chapter 7, “Working 
with Links”.

Attach Business Tag

Attaches a business tag to the selected link. For more information see Chapter 10, “Working with 
Business Tags”.

Detach/Edit

You can detach or edit a business tag from the selected link. For more information see Chapter 10, 
“Working with Business Tags”.

Note The Detach and Edit options are only displayed when a business tag is attached to a link.

Find Source

Finds the link source, if it exists, by highlighting the link in the map pane.
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Properties

Displays the properties of the selected link.

Ticket Shortcut Menu

The Ticket menu is displayed when you right-click the ticket in the ticket pane. The Ticket menu enables 
the network administrator to view ticket properties and to highlight a device that is the source of a ticket. 
The Ticket menu also enables you to acknowledge, clear and remove a ticket. For more information see 
Chapter 8, “Working with Tickets”.

Acknowledge

Acknowledges that the ticket is being handled and the ticket is displayed as true in the ticket pane. 
Acknowledging an alarm removes the alarm icon from the device icon.

Note Multiple tickets can be acknowledged at the same time.

Clear

Approves the reported faulty ticket and clears the faulty networking entity from Cisco ANA. The ticket 
is displayed as Clear in the ticket pane.

Note When a Card Out or Link Down alarm occurs the relevant information is displayed in the inventory and 
maintained in the VNE.

Remove

Removes the ticket and all its active sub-tickets from the ticket pane (this option is only available after 
the ticket has been cleared). The deleted tickets can be viewed using Cisco ANA EventVision.

Note • Multiple tickets can be removed at the same time.

• When a ticket is removed the information is no longer displayed in the inventory and is removed 
from the VNE.

Clear and Remove

Approves the reported faulty ticket and clears the faulty networking entity from Cisco ANA. In addition, 
the ticket, and all its active sub-tickets are removed from the ticket pane.

Find Source

Finds the ticket source, if it exists, by highlighting the device or link in the map pane.

Properties

Displays the Ticket Properties dialog box enabling you to view ticket information, including impact 
analysis details of the affected parties and correlated alarms.
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Changing a User Password
Cisco ANA NetworkVision enables the user to change his/her login password.

Note The administrator can also change the user password in Cisco ANA Manage.

Note Cisco ANA NetworkVision has the following pre-configured password defaults; the administrator can 
however modify these defaults using the Cisco ANA Registry:

• The minimum length of the user password is 6 characters.

• The maximum length of the user password is 10 characters.

• The minimum number of digits that must be included in the user password is 1.

To change a user password:

Step 1 Select Change User Password from the Tools menu. The Change User Password dialog box is 
displayed.

The following fields are displayed in the Change User Password dialog box:

• Old password—Enter the old user password.

• New password—Enter the new user password.

• Confirm password—Enter the new user password again to confirm the new password.

Step 2 Click OK. The change will take effect the next time that you log in to the application.

Note Clicking Show Password Rules in the Change User Password dialog box, displays the password 
rules.

Selecting Cisco ANA NetworkVision Map and Alarm Options
Cisco ANA NetworkVision enables you to customize the startup and display options.

To customize Cisco ANA NetworkVision:

Step 1 Select Options from the Tools menu. The Options dialog box is displayed.

The following checkbox is displayed in the Workspace Info area:

• Load Workspace On Startup—Your workspace is automatically loaded when logging in.

The Display tab enables you to define the display options for the application, for example, whether 
business tags are displayed. The Display tab is shown below.

The following checkboxes are displayed in the Severity area:
2-31
Cisco Active Network Abstraction NetworkVision User Guide, Version 3.6

OL-12500-01



 

Chapter 2      Getting Started
    Logging Out
• Show Severity Text—Displays severity labels in the tree pane and map pane, as per the formula 
described in New Ticket Propagation, page 2-16.

• Show Acknowledged—Displays a critical alarm severity even after the alarm is acknowledged.

• Show Propagated—Displays only the alarms on the specific entity, namely, it does not display 
propagated alarms.

The following radio buttons are displayed in the Display Name area:

• Do not use Business Tag—Select this option to display the original network element name only.

• Add Business Tag to name—Select this option to display the original network element name and 
the name of the business tag.

• Replace name with Business Tag—Select this option to replace the network element name with the 
name of the business tag. When a subscriber is attached to a port the name of the subscriber is also 
added.

The Audio tab enables you to define whether sounds are used when an alarm is triggered and what these 
sounds will be. 

You can select whether or not sound alarms are enabled, by selecting the Enable Audio Response for 
Alarm checkbox is displayed at the top of the Audio tab.

Selecting the Enable Audio Response for Alarm option enables the chosen sound files to be played when 
an alarm is triggered. You can select different sound files for critical, major, and minor alarms. 

The following fields are displayed in the Alarm area:

• Critical—Enables you to define and test the .wav file that is used to alert the user when a critical 
alarm is triggered.

• Major—Enables you to define and test the .wav file that is used to alert the user when a major alarm 
is triggered.

• Minor—Enables you to define and test the .wav file that is used to alert the user when a minor alarm 
is triggered.

The following checkbox is displayed in the Alarm area:

• Loop Sound on Critical Alarm—Defines whether the critical alarm sound is played once only or 
is continuous, namely, loops.

Step 2 Define the options that you require.

Step 3 Click OK/Apply to save your changes. The changes will take affect when the application is restarted.

Logging Out 
When you have finished working with Cisco ANA NetworkVision you can log out of the application. 
Any open maps and the workspace are automatically saved when you log out.

To log out of Cisco ANA NetworkVision:

Step 1 From the File menu, select Exit or click in the right-hand top corner of the Cisco ANA NetworkVision 
window. A confirmation message is displayed.

Step 2 Click Yes. The Cisco ANA NetworkVision window is closed.
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Note If the map appearance has changed a message is displayed asking you whether to save the current 
appearance of the map(s).
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